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File	excel	bị	khóa	không	chỉnh	sửa	được.

1Mở	khóa	file	Word	quên	mật	khẩu	bằng	WordPad	Bước	1:	Chọn	vào	file	Word	mà	bạn	muốn	mở.	Sau	đó,	nhấn	chuột	phải	>	Chọn	Open	with	>	Chọn	Choose	another	app.	Bước	2:	Bạn	chọn	vào	WordPad	và	nhấn	OK	để	mở	file	Word	bằng	phần	mềm	WordPad.		Bước	3:	Sau	khi	mở	thành	công	file	Word	trên	phần	mềm	WordPad,	bạn	có	thể	sao	chép,
chỉnh	sửa	file	một	cách	bình	thường.	2Mở	khóa	file	Word	quên	mật	khẩu	bằng	Notepad	Bước	1:	Đầu	tiên,	bạn	mở	file	Word	và	nhấn	chọn	File.	Bước	2:	Chọn	vào	Save	As.	Bước	3:	Bạn	lưu	file	Word	ở	định	dạng	Word	XML	Document	(.xml)	trong	mục	Save	as	type.	Sau	đó,	nhấn	Save	để	lưu	lại.	Bước	4:	Chọn	vào	file	Word	ở	định	dạng	.xml	mà	bạn	vừa	lưu.
Sau	đó,	nhấn	chuột	phải	>	Chọn	Open	with	>	Chọn	Notepad.	Bước	5:	Sau	khi	tài	liệu	được	mở	trên	Notepad,	bạn	chọn	vào	Edit	>	Chọn	Replace	hoặc	có	thể	nhấn	tổ	hợp	phím	tắt	Ctrl	+	H.	Bước	6:	Tại	mục	Find	what	bạn	nhập	w:enforcement="1"	và	mục	Replace	with	bạn	nhập	w:enforcement="0".	Sau	đó,	nhấn	Replace	all	để	thay	thế.	Bước	7:	Tiếp
theo,	bạn	nhấn	File	>	Chọn	Save	để	lưu	lại.	Bước	8:	Bạn	mở	lại	file	Word	được	lưu	ở	dạng	.xml	và	chọn	File.	Bước	9:	Chọn	Save	As.	Bước	10:	Chọn	lưu	file	Word	ở	định	dạng	.doc	hoặc	.docx	trong	mục	Save	as	type.	Sau	đó,	nhấn	Save	để	lưu	lại.	Vậy	là	bạn	có	thể	mở	file	và	chỉnh	sửa	như	bình	thường.	3Mở	khóa	file	Word	quên	mật	khẩu	bằng	cách	đổi	tên
thành	.zip/.rar	Bước	1:	Chọn	vào	file	Word,	nhấn	chuột	phải	và	chọn	Rename.	Bước	2:	Bạn	đổi	đuôi	định	dạng	của	file	Word	từ	đuôi	.docx	thành	.zip.	Lưu	ý:	Nếu	máy	tính	của	bạn	không	hiển	thị	định	dạng	file,	bạn	chọn	vào	View	trên	thanh	Menu	>	Chọn	File	name	extensions.	Bước	3:	Sau	đó,	nhấn	Yes	để	chấp	nhận	lưu	file	mới	với	định	dạng	.zip.	Bước
4:	Bạn	chọn	vào	file	.zip	vừa	lưu,	nhấn	chuột	phải	>	Chọn	Open	with	>	Chọn	Windows	Explorer.	Bước	5:	Bạn	chọn	vào	mục	word.	Sau	đó,	xóa	file	settings.xml.	Bước	6:	Bạn	sửa	đuôi	file	.zip	thành	.docx.	Bước	7:	Bạn	mở	lại	file	Word	và	lúc	này	bạn	có	thể	chỉnh	sửa	tài	liệu	tùy	ý.	4Mở	khóa	file	Word	quên	mật	khẩu	bằng	phần	mềm	Bước	1:	Đầu	tiên,	bạn
tải	và	cài	đặt	phần	mềm	Recover	Excel	File	Password​	theo	liên	kết	TẠI	ĐÂY.	Bước	2:	Sau	khi	cài	đặt	xong,	mở	phần	mềm.	Sau	đó,	nhấn	vào	mục	Word	và	chọn	Next.	Bước	3:	Nhấn	Open	để	chọn	file	Word	bạn	muốn	tìm	mật	khẩu.	Bước	4:	Bạn	chọn	file	Word	và	nhấn	Open	để	tải	file	Word	lên.	Bước	5:	Sau	đó,	bạn	nhấn	Recover	để	phần	mềm	bắt	đầu	dò
tìm	mật	khẩu.	Thời	gian	dò	tìm	nhanh	hay	chậm	còn	tùy	thuộc	vào	độ	mạnh,	dài	của	mật	khẩu.	Bước	6:	Sau	khi	dò	tìm	xong,	mật	khẩu	sẽ	được	hiển	thị	lên	màn	hình.	5Mở	khóa	file	Word	quên	mật	khẩu	trực	tuyến	Bước	1:	Bạn	nhấn	vào	liên	kết	TẠI	ĐÂY.	Bước	2:	Chọn	Drop	file	to	upload	để	tải	file	Word	cần	mở	khóa.	Bước	3:	Bạn	chọn	file	Word	và	nhấn
Open	để	tải	file	Word	lên.	Bước	4:	Sau	một	vài	phút,	màn	hình	sẽ	hiển	thị	mật	khẩu	của	file	Word,	bạn	có	thể	dùng	mật	khẩu	này	để	mở	file	Word	và	có	thể	chỉnh	sửa	được	văn	bản	trong	file.	Trên	đây	là	hướng	dẫn	cách	mở	khóa	lại	file	Word	khi	quên	mật	khẩu.	Mong	rằng	từ	những	hướng	dẫn	trong	bài	viết,	bạn	có	thể	thực	hiện	thành	công!	Các	file
được	định	dạng	pdf	có	độ	bảo	mật	cao	nên	khi	các	bạn	muốn	chỉnh	sửa	cũng	như	copy	các	nội	dung	thật	khó.	Tuy	nhiên,	bạn	hoàn	hoàn	có	thể	copy	các	nội	dung	trong	file	pdf	bằng	cách	mở	khóa	chúng.	Với	bài	viết	này,	blog	hỗ	trợ	sẽ	hướng	dẫn	bạn	các	công	cụ	mở	khóa	file	pdf	để	bạn	dễ	dàng	thực	hiện	các	thao	tác	chỉnh	sửa	trên	file,	copy	file	pdf	bị
khóa	một	cách	đơn	giản	nhất	mà	ai	ai	cũng	có	thể	làm	được	bên	dưới	nhé!	Như	thế	nào	là	file	pdf	bị	khóa?	Nhận	diện	file	pdf	bị	khóa	là	khi	bạn	mở	tệp	dữ	liệu	đó	ra,	các	tính	năng	sẽ	bị	mờ	đi	và	bạn	không	thể	điều	chỉnh	các	dữ	liệu	trong	file.	Đó	chính	là	file	pdf	bị	khóa	không	thể	chỉnh	sửa,	in	ấn,	cut,	copy.	Để	có	thể	chỉnh	sửa	những	điều	bạn	mong
muốn	trên	file	pdf	đã	bị	khóa	này,	bạn	cần	phải	mở	khóa	file.	Vì	vậy,	hãy	tiếp	tục	theo	dõi	bài	viết	của	mình	nhé!	Hình	ảnh	file	pdf	bị	khóa	là	khi	các	định	dạng	trong	đó	có	copy	bị	mờ	đi	Tổng	hợp	các	dạng	khóa	file	pdf	hiện	nay	bạn	nên	biết	Trước	khi	vào	bài	viết	chia	sẻ	về	cách	copy	file	pdf	bị	khóa	thì	mình	cũng	xin	được	nói	sơ	qua	về	các	dạng	khóa
file	này	ở	phần	bên	dưới.	Thông	thường,	khóa	file	pdf	có	hai	dạng	như	sau	Khóa	mở	file:	Với	đối	tượng	file	này,	người	sở	hữu	đã	mã	hóa	mật	khẩu,	bạn	được	biết	mật	khẩu	thì	mới	có	thể	mở	file.	Loại	khóa	này	thì	không	thể	phá	được	Khóa	chỉnh	sửa,	in	ấn:	Đây	là	định	dạng	mà	chính	ta	có	thể	dễ	dàng	bẻ	khóa.	File	pdf	bị	khóa	chỉnh	sửa,	in	ấn	thì	chúng	ta
có	thể	xem	các	nội	dung	bình	thường	tuy	nhiên	không	thể	chỉnh	sửa	được.	Loại	này,	chúng	ta	có	thể	dễ	dàng	bẻ	khóa	Hướng	dẫn	các	cách	copy	file	pdf	bị	khóa	hiệu	quả	Để	copy	được	file	pdf	bị	khóa,	bạn	cần	phải	mở	khóa	file.	Sau	khi	đã	mở	khóa	xong,	bạn	có	thể	hoàn	thành	các	thao	tác	tùy	thích	trong	đó	có	copy.	Để	mở	file	pdf	bị	khóa,	bạn	có	thể
thực	hiện	bằng	2	cách:	Đó	chính	là	bẻ	khóa	bằng	phần	mềm	tải	về	máy	hoặc	bẻ	khóa	trên	các	trang	mở	khóa	online.	Dưới	đây	là	một	số	phần	mềm	và	trang	web	uy	tín	mà	bạn	có	thể	thực	hiện	được	thao	tác	này	một	cách	dễ	dàng.	Dùng	Free	PDF	Password	Remover	copy	file	pdf	bị	khóa	Bước	1:			Bạn	click	chuột	mở	phần	mềm	Free	PDF	Password
Remover	có	nền	màu	đỏ	trên	máy	tính.	Còn	nếu	máy	tính	của	bạn	chưa	có	phần	mềm	này	thì	hãy	nhấn	vào	đây	để	cài	đặt	về	máy	nhé	Bước	2:		Trên	thanh	công	cụ,	nhấn	nút	Add	File	để	chọn	tập	file	PDF	cần	mở	khoá.	Bước	3:	Chọn	file	PDF	cần	được	mở	khóa	và	nhấn	Open,	phần	này	thì	không	giới	hạn	các	file,	bạn	có	thể	chọn	nhiều	file	nếu	muốn.
Bước	4:	Sau	khi	đã	tải	các	file	lên	thành	công,	bạn	chọn	Remove	Passwords.	Bước	5:	Bạn	cần	phải	nhập	mật	khẩu	khi	nhận	được	thông	báo	này,	sau	đó	->	chọn	OK	Bước	6:	Bạn	nhập	password	để	mở	file	và	chọn	OK.	Bước	7:	Sau	khi	mở	khóa	thành	công,	thư	mục	chứa	file	PDF	sẽ	tự	động	mở	lên,	file	pdf	đã	mở	khóa	có	đuôi	_unprotected	bạn	có	thể	theo
dõi	hình	để	dễ	dàng	nhận	biết.	Bước	8:	Sau	khi	hoàn	thành	bước	7	thì	bạn	hoàn	toàn	có	khả	năng	copy,	chỉnh	sửa	và	in	ấn.	Các	tính	năng	thao	tác	với	văn	bản	được	hiển	thị	đầy	đủ	Ở	phần	bên	trên	mình	chia	sẻ	đến	với	các	bạn	về	một	trong	những	cách	giúp	copy	file	pdf	khi	bị	khóa	rồi	nhưng	nếu	như	mọi	người	cảm	thấy	muốn	tìm	hiểu	thêm	thì	dưới	đây
mình	cũng	xin	được	gửi	đến	mọi	người	những	trang	website	online	giúp	mọi	người	thực	hiện	được	điều	đó	mà	không	cần	đến	phần	mềm	thứ	3	(	nếu	cần	thì	cũng	có	thể	vào	đường	dẫn	phần	mềm	PDF	để	tham	khảo	nhiều	ứng	dụng	hơn	nhé!	Ngoài	ra	dưới	đây	là	những	ứng	dụng	copy	file	pdf	bị	khóa	trực	tuyến	mà	mình	chia	sẻ	bên	dưới,	mọi	người	cùng
tham	khảo	nhé!	Top	5	trang	ứng	dụng	trực	tuyến	mở	khóa	file	pdf	Nếu	bạn	là	người	không	thường	xuyên	sử	dụng	các	file	pdf	và	nhận	thấy	rằng	việc	tải	một	phần	mềm	về	thật	phức	tạp	và	các	thao	tác	khó	nắm	bắt	so	với	mình		thì	bạn	có	thể	chọn	1	trong	5	ứng	dụng	trực	tuyến	dưới	đây.	Bởi	chúng	đều	hỗ	trợ	được	bạn	nhanh	gọn	và	dễ	sử	dụng.	Trang
Free	My	PDF	giúp	mở	khoá	file	PDF	Khi	truy	cập	vào	trang	web	freemypdf	bạn	có	thể	thấy	các	chức	năng	của	cúng	được	định	dạng	bên	tay	phải	với	nhiều	tệp	file	có	thể	chuyển	đổi	khác	nhau:	Từ	FREE	EDIT	PDF,	FREE	CONVERT	PDF	TO	WORD,	FREE	PDF	FILLER,….	Để	bắt	đầu	mở	khóa	file,	đối	với	trình	duyệt		Google	Chrome		bạn	chọn	nút		Choose
File,	với	trình	duyệt	Firefox	hoặc	IE	thì	chọn	Browse…	Sau	đó	chọn	tập	tin	cần	mở	khóa	tối	đa	khoảng	150MB	->	Do	it!.	Sau	đó	tập	tin	được	tải	về	tự	động	lưu	ở	máy	tính	Smallpdf	giúp	mở	khoá	file	PDF	trực	tuyến	Tại	giao	diện	trang	chủ	smallpdf		,	bạn	chỉ	cần	chọn	file	->	Mở	khóa	file	PDF	là	xong.	PDFunlock	giúp	mở	khoá	file	PDF	trực	tuyến	Với
sodapdf	thực	hiện	tao	tác	tương	tự	như	2	website	trên.	Online	2	PDF	giúp	mở	khoá	file	PDF	trực	tuyến	Tại	online2pdf	bạn	cần		nhấn	Select	files	để	chọn	file	PDF	rồi	ấn	Convert.	Nếu	bạn	chọn	nhầm	file	và	muốn	thay	đổi	file	thì	có	thể	ấn	Reset.	Ensode	giúp	mở	khoá	file	PDF	trực	tuyến	Đây	là	vị	cứu	tinh	khi	file	của	bạn	lớn	hơn	150M,	tại	trang	web	này
dung	lượng	để	có	thể	gỡ	bỏ	giới	hạn	lên	đến	5MB.	Để	mở	khóa	file,	bạn	cần	nhấn	nút	Choose	File	và	phải	đánh	dấu	vào	nút	tùy	chọn	I	accept	the	terms	and	conditions	->	Nhấn	Submit.	Tổng	kết	Bài	viết	vừa	rồi	blog	hỗ	trợ	đã	hướng	dẫn	bạn	cách	mở	khóa	file	pdf	để	bạn	dễ	dàng	có	thể	thực	hiện	các	tính	năng	trong	đó	có	copy	file	pdf	bị	khoá.	Hy	vọng
bài	viết	đã	hướng	dẫn	bạn	mở	khóa	file	một	cách	dễ	dàng,	và	bạn	đừng	quên	ghé	để	cập	nhật	những	kiến	thức	mới	nhất	về	những	cách	xử	lý	file	pdf	mới	nhất	nhé	và	còn	nhiều	bài	viết	hữu	ích	hơn	nữa	tại	thủ	thuật	hay	chờ	bạn	khám	phá	đó!	

Jan	15,	2022	·	#4.	Cách	cài	đặt	ứng	dụng	Android	trên	Windows	11	thông	qua	file	APK	+	Bước	1:	Bên	cạnh	việc	cài	đặt	các	ứng	dụng	có	sẵn	trên	Amazon	Appstore	thì	bạn	còn	có	thể	cài	đặt	thêm	nhiều	ứng	dụng	Android	khác	thông	qua	các	trang	web	cung	cấp	file	APK	uy	tín.	Aug	05,	2021	·	Kiểu	chèn:	Chèn	bằng	hình	ảnh	SVG.	Nguồn	icon:	3	nguồn
phổ	biến	là	Font	Awesome,	Flat	Icon	và	Material	mình	sẽ	hướng	dẫn.	Các	nguồn	online	khác	bạn	có	thể	tự	làm	theo	tương	tự	nha.	Thay	đổi	kích	cỡ	và	màu	sắc:	Sau	khi	chèn	icon	dạng	SVG	vào	PowerPoint	chúng	sẽ	chuyển	thành	khối	shape	nên	bạn	có	thể	co	giãn	kích	thước	...	Truy	cập	trang	youtube	từ	trình	duyệt	hoặc	mở	ứng	dụng	Youtube	từ	thiết	bị
Android	của	bạn,	sau	đó	copy	link	video	bạn	muốn	tải.	Dán	link	video	vào	box	tìm	kiếm.	Bạn	cũng	có	thể	nhập	từ	khóa	tại	đây	để	tìm	kiếm	video	tải	về.	Bước	1:	Tại	giao	diện	chính	nhấn	chọn	File	=>	chọn	file	PDF	bị	khóa	trong	máy	tính.	Bước	2:	Tích	chọn	vào	ô	vuông	và	nhấn	Mở	khóa	File	PDF.	Sau	khi	mở	được	chức	năng	khóa	của	file	PDF,	bạn	có	thể
copy	nội	dung	của	file	PDF	một	cách	dễ	dàng	thông	qua	phần	mềm	Foxit	Reader.	Such	options	then	apply	if	you	later	use	ALTER	TABLE	to	convert	the	table	to	use	a	different	storage	engine.	ENGINE.	Specifies	the	storage	engine	for	the	table,	using	one	of	the	names	shown	in	the	following	table.	...	The	innodb_file_per_table	variable	must	be	enabled
to	use	the	DATA	DIRECTORY	clause.	The	full	directory	path	must	be	specified	...	Sep	01,	2021	·	Khóa	file	PDF	không	cho	chỉnh	sửa	nhằm	tăng	tính	bảo	mật	hơn	cho	tài	liệu	của	mình	là	một	trong	những	thủ	thuật	mà	những	ai	hay	sử	dụng	định	dạng	file	này	nên	biết.	Ở	bài	viết	dưới	đây,	ComputechZ	sẽ	chia	sẻ	tới	các	bạn	5	cách	khóa	file	PDF	giúp	bạn
tự	bảo	vệ	được	tài	liệu	của	mình	tránh	bị	người	nhòm	...	Nov	05,	2020	·	Sau	đó	trong	giao	diện	nhấn	nút	Browse	rồi	chọn	file	acad	trong	thư	mục	AutoCAD	rồi	nhấn	Add.Sau	đó	nhấn	Options	bên	dưới..	Cuối	cùng	bạn	nhấn	vào	High	performance	rồi	nhấn	Save	để	lưu	lại..	4.	Giảm	dung	lượng	file	CAD.	Khi	bạn	giảm	dung	file	CAD	cũng	sẽ	làm	tăng	tốc	quá
trình	mở	file	CAD	trên	phần	mềm.	Truy	cập	trang	youtube	từ	trình	duyệt	hoặc	mở	ứng	dụng	Youtube	từ	thiết	bị	Android	của	bạn,	sau	đó	copy	link	video	bạn	muốn	tải.	Dán	link	video	vào	box	tìm	kiếm.	Bạn	cũng	có	thể	nhập	từ	khóa	tại	đây	để	tìm	kiếm	video	tải	về.	Trang	web	về	thủ	thuật	điện	thoại,	máy	tính,	mạng,	học	lập	trình,	sửa	lỗi	máy	tính,	cách
dùng	các	phần	mềm,	phần	mềm	chuyên	dụng,	công	nghệ	khoa	học	và	cuộc	sống	Miễn	phí,	không	có	watermark	hoặc	đăng	ký.	Chỉnh	sửa	tệp	PDF	miễn	phí.	Điền	&	ký	PDF.	Thay	đổi	văn	bản	và	liên	kết	hiện	tại.	Tìm	và	thay	thế	văn	bản.	…	Jun	10,	2022	·	Kết	quả:	Các	bạn	có	thể	thấy,	sau	khi	chuyển	đổi	định	dạng,	file	cũ	định	dạng	*.ppt(1)	có	kích	thước
1.58	MB	đã	giảm	xuống	chỉ	còn	0.99	MB	khi	ở	định	dạng	*.pptx(2).	Đấy	là	mức	giảm	rất	đáng	kể	đặc	biệt	là	đối	với	các	file	trình	chiếu	lớn	có	kích	thước	hàng	trăm	MB.	Ngoài	các	khóa	học	miễn	phí	ITFORVN	còn	tổ	chức	các	chuyên	đề	talkshow/workshop	công	nghệ	vào	chủ	nhật	hàng	tuần,	cafe	công	nghệ	,	chương	trình	mentor	cho	Admin	ITFORVN
với	sự	tham	gia	của	các	anh	em	có	kinh	nghiệm	trong	lĩnh	vực	IT.	Trong	một	số	ít	trường	hợp,	bộ	.NET	Framework	trên	máy	tính	của	bạn	có	thể	bị	lỗi	(có	thể	do	thiếu	file	trong	quá	trình	cài	đặt,	do	bị	virus	hay	một	nguyên	nhân	bất	kì	nào	khác...),	bạn	có	thể	sửa	lại	bộ	.NET	Framework	bằng	cách	sau:	Sử	dụng	.NET	Framework	Repair	Tool	Nén	file	là
một	phương	pháp	hữu	ích	để	giúp	bạn	dễ	dàng	gửi	nhiều	tập	tin	dữ	liệu	cho	nhiều	người	cùng	lúc.Đây	cũng	chính	là	chia	sẻ	của	Hosting	Việt	thông	qua	bài	hướng	dẫn	chi	tiết	về	cách	nén,	giải	nén	file	đơn	giản	và	nhanh	chóng.	Blog	Chia	Sẻ	Kiến	Thức	về	máy	tính,	điện	thoại	và	công	nghệ.	Tổng	hợp	các	thủ	thuật	máy	tính	chuyên	sâu,	thủ	thuật	sử	dụng
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sinh	và	giáo	viên	trong	và	ngoài	trường	!!!	-	Hiện	tại,	sau	mỗi	1	UNIT	trong	SGK	Tiếng	Anh	10,	11	&	12,	chúng	tôi	đã	có	...	Mở	khóa	file	PDF.	Trước	khi	đi	tìm	hiểu	về	cách	copy	file	PDF	thì	chúng	ta	hãy	đến	với	cách	mở	khóa	file	PDF.	Như	các	bạn	cũng	đã	biết	thì	đối	với	những	file	PDF	bị	khóa	thì	để	có	thể	copy	cũng	như	chỉnh	sửa	file	cần	phải	mở
khóa	mới	có	thể	thực	hiện	được.	Dec	14,	2021	·	PDF	như	nối,	chia	nhỏ,	nén,	đặt	bảo	mật	hoặc	mở	khóa	file.	1.	Hướng	dẫn	nhanh	...	Bước	2:	Nhấn	“Convert	and	Download”	để	bắt	đầu	chuyển	đổi.	...	Tại	sao	khi	chuyển	sang	file	word	bị	lỗi.	cách	khắc	phục	như	thể	nào.	Em	thấy	1	số	người	bảo	nên	chuyển	từng	trang	Feb	17,	2020	·	#	Cách	3:	Sử	dụng
website	Download-PDF.GDrive.VIP	để	tải	file	pdf	Google	Drive	bị	chặn	download	(hoạt	động)	Truy	cập	website	và	làm	theo	hướng	dẫn	dưới	đây:.	Lưu	ý:	Ở	ô	số	4.Nhập	độ	phân	giải,	các	bạn	nên	nhập	tối	đa	1500	thôi,	vì	càng	cao	thì	sẽ	load	càng	chậm	và	có	thể	bị	lỗi	Jun	16,	2022	·	Chuyển	PDF	sang	Word,	đổi	file	PDF	thành	văn	bản	mà	vẫn	giữ	nguyên
định	dạng,	chất	lượng	là	yêu	cầu	cơ	bản	khi	người	dùng	thực	hiện	chuyển	đổi	PDF	sang	DOCX.Hãy	tham	khảo	bài	viết	để	chuyển	PDF	thành	Word	dễ	dàng	mà	vẫn	đảm	bảo	yêu	cầu	nhé.	Các	tập	tin	PDF	được	nhiều	người	lựa	chọn	bởi	sự	gọn	nhẹ	...	Jul	15,	2022	·	Bước	1:	Trong	file	PowerPoint,	bạn	chọn	thẻ	File.	Chọn	thẻ	File.	Bước	2:	Chọn	Export,	sau
đó	bấm	Create	a	Video.	Chọn	Export	>	Bấm	Create	a	Video.	Bước	3:	Bạn	chọn	chất	lượng	hình	ảnh	của	video	mà	mình	mong	muốn	như	hình	dưới.	PowerPoint	cho	bạn	4	lựa	chọn	chất	lượng	video	như	sau:	Chuyển	đổi	file	hình	ảnh	thành	văn	bản,	trực	tuyến	và	miễn	phí.	Công	cụ	chuyển	đổi	tài	liệu	văn	bản	trực	tuyến	để	trích	xuất	văn	bản	từ	tất	cả	các
file	có	định	dạng	hình	ảnh	như	PNG,	JPG,	GIF,	TIF	và	các	định	dạng	khác	nữa!	Truy	cập	trang	youtube	từ	trình	duyệt	hoặc	mở	ứng	dụng	Youtube	từ	thiết	bị	Android	của	bạn,	sau	đó	copy	link	video	bạn	muốn	tải.	Dán	link	video	vào	box	tìm	kiếm.	Bạn	cũng	có	thể	nhập	từ	khóa	tại	đây	để	tìm	kiếm	video	tải	về.	Oct	05,	2020	·	Bước	2:	Chọn	file	PDF	bị	khoá
và	nhấn	Open.	Bước	3:	Nhập	password	của	file	PDF	bị	khóa.	Bước	4:	Chọn	định	dạng	chuyển	là	File	format	is	retained	và	chọn	Convert.	Bước	5:	Sau	khi	mở	khóa	xong	trang	web	sẽ	tự	động	chuyển	về	chế	độ	…	Jun	09,	2022	·	Cách	#1:	Sử	dụng	Code	VBA	để	ghép	nhiều	file	Excel	+	Bước	1:	Bạn	bật	ứng	dụng	Excel	của	mình	lên	rồi	nhấn	tổ	hợp	phím	Alt
+	F11	để	bât	cửa	sổ	VBA	lên.	Đối	với	Excel	2007:	Bạn	nhấn	vào	icon	biểu	tượng	Excel	Button	(ở	góc	trên	cùng	bên	trái)	của	file	Excel	=>	chọn	Excel	Options	=>	Một	cửa	sổ	xuất	hiện,	bạn	chọn	...
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